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THE SCIENCE OF WHERE™

Datapreparatie met Excel (optioneel)

Data voor analyses wordt helaas niet altijd netjes aangeleverd in de vorm van featureklassen in een
geodatabase. Soms moeten we aan de hand van statistische data in Excel onze geografische data verrijken
(d.m.v. een join) of geografische data maken door middel van codrdinaten in een tabel. Het vereist echter
veel nauwkeurigheid om data uit Excel te gebruiken in een GIS systeem.

In deze oefening gaan we aan de slag met data in Excel op deze twee manieren. Eerst gaan we ruwe data in
Excel gereed maken voor het gebruik in een analyse. We zullen daarna XY-data uit een Excel sheet
gebruiken om puntendata te creéren.

Alle data die we in deze oefening gaan gebruiken voor de analyse is te vinden in het mapje:
C:\EsriTraining\WVAAP. Download eventueel de oefendata uit het de leeromgeving en pak het zipbestand uit
en kopieer het naar de hier boven genoemde locatie.

De oefening bestaat uit de volgende stappen:

Stap 1:  Opmaak Excel bestand met adreSSEN ........ccoo oo 1

Stap 2:  X-Y data in EXCEl FOrMAAL .........uuuiiiiieiiiiiiiiii et e e et e e e e s s st e e e e e e e e s nnnrraeeeeeens 4

Stap 1: Opmaak Excel bestand met adressen

Wanneer u in een virtuele omgeving werkt dan is de kans groot dat u geen Excel tot uw
beschikking heeft. In dat geval kunt u deze oefening niet doen. U kunt deze stap op een
later moment op uw eigen werkplek uitvoeren. Deze oefening is gemaakt met Excel in
Windows 11 (Version 2504), het kan zijn dat u met een andere versie van Excel werkt en
de oefeningen er iets anders uit zien.

Er is op het Internet veel data te vinden in Excel-, CSV- of andere tabelformaten. Zo is er bijvoorbeeld op de
website van het CBS (https://opendata.cbs.nl) veel open data te vinden, zowel geografische data in
shapefile-formaat als tabeldata. Ook op het Dataportaal van de Nederlandse overheid
(https://data.overheid.nl) is veel data te vinden in Excel- of CSV-formaat, data die relevant kan zijn voor een
geografische analyse.

O Kijk eens op deze websites en ontdek wat voor data hier te vinden is die eventueel geschikt is voor
gebruik in een GIS systeem.

\|/

Q Denk hierbij aan data met een geografische component (adres, codrdinaten) of data
die gekoppeld kan worden met bestaande featureklassen door middel van key fields (denk
aan de CBS buurt en wijk kaarten).
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Voor deze opdracht maken we gebruik van een ruwe dataset (HogescholenUniversiteiten.xls) van het
Dataportaal van de Overheid die alvast gedownload is en terug te vinden is in:
C:\EsriTraining\VAAP\Data_Preparatie

0 Open dit bestand in Excel.

Het bestand bestaat uit veel overbodige informatie en daarnaast heeft het kolomnamen met spaties, zijn
nummers opgeslagen als tekst en kent de tabel teveel opmaak. Op deze manier kan ArcGIS Pro het Excel-
bestand niet inlezen. Daarom zal het bestand eerst moeten worden bewerkt.

O Verwijder de opmaak van het Excel-bestand. Selecteer hiervoor alleen de kolommen die wij gaan
gebruiken (A t/m G), inclusief de headers, en plak deze vervolgens in een schoon en leeg Excel-bestand.

Paste Values

Kies hierbij voor Paste Values
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1 |SOORT HO BEVOEGD ( BEVOEGD « STRAATNA HUISNUM! POSTCODE PLAATSNAs GEMEENTE GEMEENTE DENOM N, TELEFOON INTERNETA STRAATNA HUISNUMI POSTCODE PLAATSNAs ADMINISTRATIEKANTOORNUMMER
2 hbo 24832 stichting CKruisplein 26 3012 CC  ROTTERDA 599 ROTTERDA Algemeen 1E+08 www.coda Kruisplein 26 3012CC  ROTTERDA
3 hbo 28901 Stichting F Nieuwekac 13511RV UTRECHT 344 UTRECHT Alzemeen 3E+08 www hku.r Pastbus 1520 3500 BM UTRECHT
4 hbo 29615 Stg. Gerrit. Fred. Roes 96 1076 ED  AMSTERDA 363 AMSTERDA Algemeen 2 1E+08 Fred. Roes. 96 1076 ED AMSTERDA
5 |hbo 30041 Stg. Kaht. (Ten Oever: 68 8012 EW ZWOLLE 193 ZWOLLE  Rooms-Ka  3.8E+08 www kpz.r Ten Oever: 68 B012 EW ZWOLLE
6 hbo 30156 Stichting M Rengerslai 10 8917 DD LEEUWARL 80 LEEUWARL Algemeen  5.8E+08 www.nhl.r Postbus 1080 8900 CB LEEUWARL
7 |hbo 30163 Stichting  Zernikedre 11 2333CK  LEIDEN 546 LEIDEN Samenwer 7.2E+08 www hslei Postbus 382 2300A]  LEIDEN
8 |hbo 30183 Stichting A Prof Cobbe 13 5037 DA TILBURG 855 TILBURG Algemeen  1.4E+08 www.avan Postbus 1097 5004 BB TILBURG
9 hbo 30205 Viaa-Gerel Grasdorps 2 8012EN ZWOLLE 193 ZWOLLE  Gereforme 3.8E+08 www.viza. Postbus 10030 8000 GA ZWOLLE
10 |hbo 30246 stichting r Edisonweg 4 4382 NW VLISSINGE| 718 VLISSINGEI Algemeen  1.2E+08 www.hz.n| Postbus 364 4380 A1 VLISSINGEI
11 |hbo 30274 Sticht. A'diJodenbree 3 1011 NG AMSTERDA 363 AMSTERD/ Algemeen 2 1E+08 Postbus 15079 1001 MB AMSTERDA
12 |hbo 30299 Stichting F Museumpi 40 3015CX ROTTERDA 599 ROTTERDA Algemeen  1.1E+08 www .hoge Postbus 25035 3001 HA ROTTERDA
13 |hbo 30327 Stichting | Jan Toorop 136 1061 AD AMSTERDA 363 AMSTERDZ Algemeen Jan Tooroj 136 1061 AD AMSTERDA
14 |hbo 30332 stichting M Mgr. Hopn 14817JT BREDA 758 BREDA Algemeen  7.7E+08 www.nhtv. Postbus 3917 4800 DX BREDA
15 |hbo 30780 Stichting S M.H. Trom 30 7513 AB  ENSCHEDE 153 ENSCHEDE Algemeen  5.3E+08 www saxic Postbus 70000 7500 KB ENSCHEDE
16 |hbo 30923 Stichting F Prinsesseg 4 2514 AN 'S-GRAVEN 518 S GRAVENF Algemeen TE+08 www kabk Postbus 11670 2502 AR 'S-GRAVEN
17 |hbo 40169 Stichting F Zernikeple 19747 A5 GRONINGE 14 GRONINGE Algemeen  5.1E+08 www .hanz Postbus 30030 9700 RM GRONINGE
18 |hbo 40205 stichting F Onderwijs 221 5223 DE 'S-HERTOG 796 S HERTOGIRooms-Ka  8.9€+08 www.hash Postbus 90108 5200 MA 'S-HERTOG
19 hbo 40235 Stg. Chr.H Oude Kerk 100 671715  EDEGLD 228 EDE Protestant  3.2E+08 www.che.r Postbus 80 671088 EDEGLD
20 hbo 40331 Stichting F Wibautstr 3-B 1091 GH AMSTERDA 363 AMSTERDA Algemeen 2 1E+08 www .hva.r Postbus 1025 1000 BA AMSTERDA
21 hbo 40516 Stichting  Padualaar 99 3584 CH UTRECHT 344 UTRECHT Algemeen B8.8E+08 www.hu.nl Postbus 573 3500 AN UTRECHT
22 |hbo 40555 stichting F Rachelsme 15612 MA EINDHOVE 772 EINDHOVE Algemeen  8.9E+08 Postbus 347 5600 AH EINDHOVE
23 hbo 40687 Stichting # Bovenbuul 27 6717 XA EDEGLD 228 EDE Protestant 8.8E+08 www.aere! Postbus 245 6710BE  EDEGLD
24 hbo 40781 Stichting [ Burgemees 2 2803PD GOUDA 513 GOUDA Reformatc 1.8E+08 www .dries Postbus 368 2800 A1 GOUDA
25 hbo 41128 Stichting Z Nieuw-Eyc 300 6419 D) HEERLEN 917 HEERLEN Samenwer 45E+08 www.zuyd Postbus 550 6400 AN HEERLEN
26 |hbo 41202 stichting £ Onderlang 9 6812CE ARNHEM 202 ARNHEM Algemeen  2.6E+08 www.artez Postbus 49 6800 AA  ARNHEM
27 hbo 41344 Stichting \ Larenstein 26-A 6882 CT  VELP GLD 275 RHEDEN  Algemeen 2 6E+08 www .hvhl. Postbus 9001 6880 GB VELP GLD
28 hbo 41350 Stichting F Theresiast 8 2593 AN 'S-GRAVEN 518 S GRAVENF Algemeen 7E+08 www.inho Postbus 95597 2509 CN  'S-GRAVEN
29 hbo 41378 Stichting  Johanna W 75 2521 EN  'S-GRAVEN 518 5 GRAVENF Algemeen TE+08 Postbus 13336 2501 EH 'S-GRAVEN
30 |hbo 41618 Stichting . Bachlaan 11 7002 MZ DOETINCH 222 DOETINCH Overige 8.8E+08 www.iselil Postbus 277 7000 AG DOETINCH
31 hbo 42609 Stichting C Campus 2 8017 CA ZWOLE 193 ZWOLLE 8.8E+08 www .wind Postbus 10090 8000 GB ZWOLLE
32 hbo 42664 Stichting T Stationssi 80 3033HJI ROTTERDA 599 ROTTERDA 1E+08 www thom Stationssi 80 3033 H] ROTTERDA
33 hbo 50338 Stichting '| Deurnesev  Nov-13 5708 AH HELMOND 794 HELMOND Rooms-Ka~  4.9E+08 www kemp Deurnesev 11 5709 AH HELMOND
34 |hbo 60763 Stichting F Brusselsel 2 2587 AH 'S-GRAVEN 518 S GRAVEN! Algemeen 7E+08 www.hotel Brusselsel 2 2587 AH 'S-GRAVEN
35 hbo 60802 Stichting L Emmasing 14 5611 AZ EINDHOVE 772 EINDHOVE Algemeen 4E+08 www.desiz Postbus 2125 5600 CC  EINDHOVE
36 hbo 72230 Stichting F Vogelsang 1 3571ZM UTRECHT 344 UTRECHT Protestant 3E+08 www.marr Postbus 85002 3508 AA UTRECHT
37 hbo 72243 Stichting F Ruitenberg 31 6826 CC  ARNHEM 202 ARNHEM Algemeen  2.6E+08 www.han.Postbus 5375 6802 E) ARNHEM
38 |wo 8 Rijksunive Broerstraz 5 9712CP  GRONINGE 14 GRONINGE Rijks SE+08 www.rug.r Postbus 72 9700 AB  GRONINGE
39 \wo 9 Universite Heidelberg 8 3584CS UTRECHT 344 UTRECHT Rijks 3E+08 www.uu.nl Pastbus 80125 3508 TC UTRECHT
40 |wo 10 Erasmus L Burgemees 50 3062 PA ROTTERDA 599 ROTTERDA 1E+08 www eur.r Postbus 1738 3000 DR ROTTERDA
41 |jwo 11 Technisch Stevinweg 1 2628CN DELFT 503 DELFT Rijks 1.5E+08 www tudel Postbus 5 2600 AA  DELFT
42 \wo 12 Technisch Groene Loj 5 5612AE EINDHOVE 772 EINDHOVE Rijks 4E+08 www.tue.n Postbus 513 5600 MB EINDHOVE
43 |jwo 13 Universite Drienerlol 5 7522 NB  ENSCHEDE 153 ENSCHEDE Rijks 5.3E+08 www .utwe Postbus 217 7500 AE ENSCHEDE
44 wo 14 Wagening Droevendz 4 6708PB  WAGENINC 289 WAGENIN( Rijks 3.2E+08 www.wur . Postbus 9101 6700 HB  WAGENINC
45 jwo 39 Universite Rapenburg 70 2311EZ LEIDEN 546 LEIDEN Rijks 7.2E+08 www leide Postbus 9500 2300 RA LEIDEN
46 IWD 20045 Protestant De Boelelz 1105 1081 HV AMSTERDA 363 AMSTERD/ Protestant 8.8E+08 www.pthu Postbus 7161 1007 MC AMSTERDA
47 |wo 20280 Maastrich Minderbrc 4 6211LK  MAASTRIC 935 MAASTRIC Rijks 4.3E+408 www.maa: Postbus 616 6200 MD MAASTRIC
48 |wo 22222 Universite Spui 21 1012 WX AMSTERDA 363 AMSTERDA Algemeen 2 1E+08 www.uva.r Postbus 19268 1000 GG AMSTERDA
49 |wo 30287 Theologisc Wilhelmir 4 7316 BT  APELDOOF 200 APELDOOF Protestant 5.6E+08 www .tua.r Wilhelmir 4 7316 BT  APELDOOFR
50 |wo 30720 Open Univ Valkenbur 177 6419 AT HEERLEN 917 HEERLEN Algemeen  4.6E+08 www.ou.nl Postbus 2960 6401 DL HEERLEN
51 \wo 30816 Stichting L Kromme N 29 3512 HD UTRECHT 344 UTRECHT Alzemeen 3E+08 www.uvh.r Pastbus 797 3500 AT UTRECHT
52 |wo 39800 Theologist Broederwe 15 8261 G5 KAMPEN 166 KAMPEN Algemeen  3.8E+08 www .tukai Broederwe 15 8261 GS KAMPEN
53 |wo 75571 Stichting k Warandel 2 5037 AB  TILBURG 855 TILBURG Rooms-Ka  1.3E+08 www.uvtn Postbus 90153 5000 LE  TILBURG
54 \lwo 75792 Het Colleg De Boelelz 1105 1081 HV AMSTERDA 363 AMSTERD/ Algemeen  2.1E+08 De Boelelz 1105 1081 HV AMSTERDA
55 |lwo 75805 Het Colleg Comenius 4 6525 HP  NUMEGEN 268 NIJMEGEN Rooms-Ka Postbus 9102 6500 HC  NIJMEGEN

Nu weet u zeker dat u alleen de kolommen die u gaat gebruiken hebt gekopieerd en alle andere kolommen
leeg zijn.

Vervolgens gaan we ervoor zorgen dat alle cijfferdata ook opgeslagen wordt als getal.

0 Maak een nieuwe kolom naast de kolom HUISNUMMER-TOEVOEGING en noem deze kolom
TOEVOEGING.

0 Selecteer de kolom HUISNUMMER-TOEVOEGING en klik op het Data tabblad.
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O

a

Kies vervolgens voor de optie Text to Columns (Data Tools sectie).

=
>
Textto

Columns

Er opent nu een menu waarmee u het tekstveld kunt omzetten naar cijfers en de toevoegingen (zoals B
en A in een losse kolom kunt zetten).

In stap 1 kies u het type data, daar is de default al goed ingesteld (delimited). Klik op Next.

In de volgende stap kiest u de scheidingstekens, waar de kolommen door gescheiden worden. Haal het
vinkje voor Tab weg en zet een koppelstreepje achter Other.

Delimiters

_JIab
_ Semicolon
_ Comma

[ space

QOther:

Klik vervolgens tweemaal op Next en vervolgens Finish.

De kolom huisnummer is nu opgeslagen als getal en de toevoegingen zijn gescheiden van de getallen.

a

a

Verander de kolomnaam HUISNUMMER-TOEVOEGING naar HUISNUMMER. Op deze manier zorgt u
ervoor dat er geen onnodige leestekens in de titels verwerkt zitten

De kolom Bevoegd Gezagnummer Nummer hebben wij niet nodig, die kunt u verwijderen.

De kolom BEVOEGD GEZAG NAAM bevat spaties. Dat is een probleem (dit kan niet in een GIS worden
ingelezen).

a

a

Verander de kolom naar: NAAM.
Verander de kolomnaam SOORT HO naar SOORT.
Als laatste moet ervoor gezorgd worden dat er geen opmaak meer in het bestand verstopt zit.

Selecteer alle data in het bestand en klik rechts (Format Cells) en vervolgens op General.
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UYL VAN AT BN NITIEYEn MUNENUEgIdan a1
Format Cells ? X

[T =N

Number Alignment Font Border Fill Protection

Category:

lGenera — PRRERS
Number NUMEGEN
Currency

Accounting General format cells have no specific number format.
Date

Time

Percentage

Fraction

Scientific

Text

Special

Custom

S W=

Lem i@ =

0 Kilik op OK.
Zoals nu te zien is, is alle onnodige opmaak uit het bestand verwijderd.

O Sla het bestand op als .xIs bestand.

Het bestand is nu gereed om toe te voegen aan ArcGIS Pro en vervolgens bijvoorbeeld te geocoderen. Voeg
het bestand toe en kijk in de attribuuttabel of alle informatie goed is opgeslagen en is meegekomen in de
tabel.

Stap 2: X-Y data in Excel formaat

Exceldata met adreslocaties (zoals hierboven) kan gegeocodeerd worden met behulp van ArcGIS Pro of
ArcGIS Online en vervolgens verder gebruikt worden (dit kost credits). Een andere manier is het gebruiken
van de codrdinaten van locaties om deze vervolgens met de tool XY Table To Point om te zetten naar
punten in een featureklasse. Hiervoor moeten de codrdinaten dan wel handmatig verzameld of aangeleverd
worden.

In deze oefening is de cotrdinatendata voor universiteiten in Nederland al verzameld door een collega en
aangeleverd in een Excel-tabel.

O Open het excelbestand UniversiteitenNL.xls (C:\EsriTraining\VAAP\Data_Preparatie).

De komma'’s in de deze Excel-tabel staan niet op de juiste plek. In Nederland (en Nederlandse
computersystemen) wordt een komma gezet tussen 'hele getallen' en decimalen. Het decimaalteken in
Engelstalige landen is de punt. In de leslokalen (en wellicht ook op uw computer) staan de
computersystemen ingesteld in het Engels, dus worden punten gebruikt als decimaalteken. In dit bestand zijn
de codrdinaten echter aangeleverd in het Nederlandse systeem (met komma'’s) en daarom zijn de
codrdinaten nu gehele getallen geworden. Voor het bestand gebruikt kan worden in ArcGIS Pro, moet dit
eerst worden aangepast. Als u het bestand importeert zal het systeem de getallen niet als codrdinaten
herkennen.
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In ArcGIS Pro: In Excel:
G H
LATITUDE = LONGITUDE latitude longitude
53197837 5792897 53,197,837 5,792,897
52090568 5123274 52,090,568 5,123,274
51917261 450723 51,917,261 4,527,232
52000623 437307 52,000,623 437,307
— = 51,451,231 5,487,888
oo sl oisis 52,241,717 5,856,179
2241711 6856179 51,985,161 5,666,465
198516 5666465 52,168,395 4,475,658
4475658 52,334,592 4,866,476
50,850,165 569,251
569251 52,368,181 4,889,664
pory 52,221,119 5,964,602
— 50,878,738 5,957,762
52221119 5964602
: 52,085,483 5,124,867
5957762 7 577 71724 A nlin B

Er zijn verschillende manieren om met het veranderen van komma'’s in decimalen om te gaan. Zo kunt u
instellen dat Excel niet het computersysteem gebruikt om het decimaalteken te bepalen, maar dat dit
handmatig wordt aangepast (File > Options > Advanced > Use System Separators).

In dit geval hebben we hier echter niets aan, omdat het systeem dan alle komma'’s verandert in punten en
dan klopt het codrdinaat niet meer.

Excel Options ? x
General =
Advanced options for warking with Excel,
Formulas
Data Editing options
Procfing After pressing Enter, move selection
Save Direction: | Down ¥
Language [ Automatically insert a decimal point

Places:

Ease of Access

Enable fill handle and cell drag-and-drop

Alert before overwriting cells

Customize Ribben Allow editing directly in cells

Quick Access Toolbar Extend data range formats and formulas
Enable automatic percent entry

Enable AutoComplete for cell values
Trust Center Automatically Flash Fill

[ Zoom on roll with IntelliMouse

Add-ins

[] Alert the user when a potentially time consuming operation occurs

Mhen this number I (in thousands) is affected: | 33,554

Use system separators

Decimal separator:

Thousands separator:

Wygor movement:

Visual

[ Do net automatically hyperlink screenshot

Cut, copy. and paste

-

Cancel

Daarom hebben we een formule nodig die de eerste komma vervangt door een punt, maar die de tweede niet
verandert.

0 Maak twee nieuwe kolommen aan naast zowel de latitude als de longitude kolom.
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O Gebruik vervolgens onderstaande formule voor het vervangen van de komma door een punt in de
latitude. Gebruik de functie om de formule en waarden te kopiéren (rechts aan het blokje trekken) om de
waarden voor de hele kolom te vullen.

=VALUE(LEFT(G2,2)&"."&RIGHT(G2,LEN(G2)-2))

G H

|atitude

531978371=VALUE(LEFT(G2,2)&"."&RIGHT(G2,LEN(G2)-2) }| |
52090568
51917261
52000623
51451231
52241717
51985161
52168395
52334592
50850165
52368181
52221119
50878758
52085483
52522234
51563264
52334592
51819627

0 Doe hetzelfde voor de longitude, maar dan met onderstaande formule. Omdat hier de punt op een
andere positie moet staan (want 1 cijfer voor het decimaalteken), is de formule net iets anders.

=VALUE(LEFT(I12,1)&"."&RIGHT(I2,LEN(12)-1))

i

Voor meer informatie over deze formule, kijk op: https://support.microsoft.com/en-
us/office/formulas-and-functions-294d9486-b332-48ed-b489-
abe7d0f9eda9#idOebbd=formulas

0O Kopieer en plak vervolgens de twee nieuw aangemaakt kolommen in de oude kolommen (latitude en
longitude), waarbij u alleen de waarden (values) kopieert. Op deze manier is het Excel-bestand zo schoon
mogelijk en worden alleen de waarden herkend, niet de formules.

o= iy

atitude

s3.1s7e37l
52.090563
51.9172611

I
320000 pacte Options:

51451 .,
52.241 L[] [:_\;3 ﬁr ﬁ;’ @" ﬁ

51.985161! _
52.168395! | Values (V)
52.334592]
50.850165]
52.368181}
52.221119!
50.878788!
52.0854831
52.522234]
51.563264]
52.334592]
51.819627|_

Versie 1.0 8 juli 2025 6


https://support.microsoft.com/en-us/office/formulas-and-functions-294d9486-b332-48ed-b489-abe7d0f9eda9#id0ebbd=formulas
https://support.microsoft.com/en-us/office/formulas-and-functions-294d9486-b332-48ed-b489-abe7d0f9eda9#id0ebbd=formulas
https://support.microsoft.com/en-us/office/formulas-and-functions-294d9486-b332-48ed-b489-abe7d0f9eda9#id0ebbd=formulas

[ J
@ esrl N ederland Datapreparatie met Excel (optioneel)

THE SCIENCE OF WHERE™

[ [
Tip: worden de cijfers afgerond? Klik dan met uw rechter muisknop op de kolom en
vervolgens op Format Cells. Klik op General en vervolgens op OK.

0 Verwijder de H en | kolom en sla het bestand op. Let hierop op dezelfde regels als in de vorige oefening
(Ruwe data in Excel formaat). Zorg ervoor dat de titels kloppen, er geen onnodige lege kolommen (delete
een aantal lege kolommen naast de latitude/longitude) zijn, etc.

0 Open vervolgens ArcGIS Pro en voeg het bestand toe aan een nieuwe map.

0 Rechtsklik op de tabel en kies Create Points from Table > XY Table to Point

L Cut o ) Copy Ctl+C 4 i Add Data From Path
B
paste L) Copy = add XY Table To Point
v [&] CopyPath X Remove stav 5 Add Graphics Layer
Clipboard Group Layer
Contents [ Open CtilsT
T | search 57 Dats Engineering Ctrl=Shift=D
== T
-_ Data Design >
Drawing Order
|| Create Chart >
4[] Maps
lew Report
New Rep
| Topo_RD
4 Standalone Tables Joins and Relates ’
[ universiteitenNLS B Creste Points From Table > | Bt Xy Table To Point
£ Geocode Table i Make XV Event Layer

' Display Route Events...
Selection >
GJ Disable Pop-ups
[ Configure Pop-ups
Data >
Sharing >
B ViewMetadata
/' Edit Metadata

2 Properties

De XY Tabel to Point tool verschijnt (ook te vinden via Analysis > Tools).
O Vul de vulden in onderstaande afbeelding:

Geoprocessing v B

® XY Table To Point )
Parameters Environments
E3Input Table

universiteitenNL.csv -

Output Feature Class
universiteitenNL

X Field
LONGITUDE
Y Field
LATITUDE
Z Field

Coordinate System
GCS_WGS_1984 - @
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0 Run de tool en de universiteiten van Nederland verschijnen nu als een punten featureklasse in de kaart.

L] h
Den Haag Utrecht

Middelburg

0
Maa®richt

2 \Joor meer informatie over het gebruik van Excel in ArcGIS Pro:
https://pro.arcgis.com/en/pro-app/help/data/excel/work-with-excel-in-arcgis-pro.htm
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